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[bookmark: _Toc439936470]Overview of General Planning
This document discusses the General Planning module and covers the concepts associated with Revenue and non-Salary Expense planning and forecasting.  By the end of this document, you should be able to:
Explain the purpose of the General Planning module
Find DeptID – Fund – Project  combinations
Use the Revenue & Expense form
Enter or adjust revenue and non-salary expenses
Understand commitment transfer accounts
Identify calculation rows
Update Completion Tracking values
Understand seeding and global assumptions
Understand the various General Planning reports available in UPlan
[bookmark: _Toc439936471]What is General Planning?
General Planning involves planning at a DeptID, Fund, Project, and Account level.  Located in the UPlan application, the General Planning module provides Forms to allow you to forecast and plan your revenue and non-salary expense items and make adjustments at an aggregated level to your employee planning results. 
General Planning is the main point of reference for planning within UPlan.  Within General Planning, you will also see information that flows from a variety of areas:
· Actual data is seeded from PeopleSoft General Ledger
· Planned commitment transfers in and out from the Commitment Tracking module
· Summary of salary and benefit expense flows from the Employee Planning module
· Summary plans for Project Uses planned in Faculty Portfolio
General Planning data will flow to the Data Warehouse and MyReports.  It will also be used by Control Points to finalize 5 year plans in Microsoft Excel. 
The General Planning module includes these forms: 
· Revenue & Expense
· Tuition & Fee Revenue Calculator
· Revenue & Non-Salary Expense Global Assumptions
The Revenue & Expense form is the primary General Planning form.  This form resembles a P&L statement.  There are two versions of this form.  Most planners will use Revenue & Expense Level C Accounts form.  FAS planners will use Revenue & Expense Level E Accounts form.  This lesson will discuss this form in detail.
The Tuition & Fee Revenue Calculator form is used by a small group of planners with tuition and fee income.  For more information on this form, see the UPlan-203 Job Aid: Tuition & Fee Revenue Calculator.
The Revenue & Non-Salary Expense Global Assumptions form is used by UPlan Level 1 and Level 2 Coordinators to set global assumptions for seeding future plans.  Planners can view the assumptions on this form as well.  Lesson 1.3 will discuss this topic in detail.
[bookmark: _Toc383598709][bookmark: _Toc439936472]Revenue & Expense Form
The Revenue & Expense form is the heart of General Planning.  Here is how the dimensions are arranged on the form:
· Page Filters: DeptID, Fund and Project (or DFP) combination
· Columns: Year, Scenario, Version and Period
· Rows: Account
[image: C:\Users\dbeaman\Desktop\2016-01-06_15-19-52.jpg]
In order to work with this form, you need to understand the layout of the dimensions and how to find appropriate DeptID, Fund, Project (DFP) combinations.  
[bookmark: _Toc383598710][bookmark: _Toc439936473]Finding DFP Combinations with Completion Tracking Report
So, how are you going to know what your valid DFP combinations are?  The Completion Tracking Report shows all DFP combinations that contain any non-zero Plan and/or GL Actuals data for the MyOrg DeptID selected.  As a result, you will see any combinations within your DeptID where actual or planning activity has occurred. 

Note: The Completion Tracking Report covers most relevant DFP combinations.  However, there may be other combinations that are valid that presently have no data and, therefore, would not show up on this report.  You can choose to plan for these as well.
To find currently-used DFP combinations:
In UCSFPlan, expand General Planning > Reports.
Select the Completion Tracking Report.
In the Page Filter area, use the MyOrg link to change the DeptIDs being reported. 
The Completion Tracking Report updates to show all combinations of DeptID, Fund and Project within this MyOrg value where data currently exists.
[image: C:\Users\dbeaman\Desktop\2016-01-06_15-27-10.jpg]
Use the report to find appropriate DFP combinations to view, input, and modify your forecasts and plans.  You may print the report or export to Excel:
To export the report to Excel, select Tools > Export to Spreadsheet.  
The report will display in Excel with additional columns, representing the calculated accounts (such as Total Revenue) for each scenario.  These can be helpful in understanding your Completion Tracking report, but you may want to delete the extraneous columns and leave only the Completion Tracking columns.
To print the report, select File > Print or click the Print icon. [image: ]   When the Print dialog box appears, make changes as desired.  You can save or open the file, called dataform.pdf by default.  Note: The report prints with each column on a separate page.
1. Right click the tab and select Close to close the Form Report.
[bookmark: _Toc383598711][bookmark: _Toc439936474]Setting DFP Combination with Page Filters in Revenue & Expense
You use the drop down menus in the Page Filters to set your DeptID – Fund – Project (DFP) combination in the Revenue & Expense form.  Type the DeptID or description.  After selecting all changes, click the Go button to update the form.  
[image: C:\Users\dbeaman\Desktop\2016-01-06_15-28-47.jpg]
Note: To show dimension names in the Page Filter area, select View > Show Dimension Name on Page.
Users enter data at planning intersections with planning-level DeptIDs, posting-level Funds, and planning-level Projects.  Users will have write access only to their assigned Planning DeptIDs.
You may also select summary members of these dimensions for read only reviewing, such as “Total Funds” or “Total Projects.”  This is especially helpful after you have input plans for all your individual funds and projects.  In addition, you can view Parent-level DeptIDs and Project Uses in place of individual DeptIDs and Projects.
[bookmark: _Toc378061518][bookmark: _Toc439936475][bookmark: _Toc378061519]Understanding DeptIDs
DeptIDs are planning units within the organizational structure.  Your UPlan access to DeptIDs is based on your User Name.  While you have view access to higher levels of the DeptID tree, you can only plan at the level of your Planning DeptIDs.  Planning DeptIDs are designated with a Planning attribute in PeopleSoft.  You can only enter and edit forecasts and plans to the Planning DeptIDs for which you have access.  
You cannot enter and edit forecasts and plans for DeptIDs above your Planning DeptIDs.
[bookmark: _Toc439936476]Understanding Project & Planning by Project Use
Remember that Project identifies the activity being planned.  A key attribute of each project is its Project Use, which identifies the category of projects for reporting purposes. 
While planning may occur at the project level in UPlan, sometimes users will need to plan ahead for activity that does not yet have a Project ID or perhaps for a group of activities without Project-specific information yet available.  Or, planners may decide to plan at the Project Use level to reduce their planning workload.  To accommodate planning in these cases, UPlan includes a series of UPlan-Only projects, 14 in total, each one identified as pertaining to a specific Project Use.  Planners may select any of these projects and enter plans on the Revenue & Expense form.  UPlan-only adjustment projects have the prefix of “ADJ” in their description.  However, be aware that you will not be able to compare plans entered at the ADJ Project level with Actual data, since no Actuals data is loaded to ADJ projects.  Instead, planners would need to run variance reports at the Total Projects or Project Use level and make appropriate comparisons.
	Project ID
	Project Description
	Project Use
	Purpose

	2011368
	ADJ Sponsored NoNIHcap
	SPONSORED_PROJ
	Adjustment projects, used in general planning and employee planning to plan additional sponsored activity not covered by Faculty Portfolio (FP). Not used in Commitment Tracking.

	2011369
	ADJ Sponsored NIHcap1
	SPONSORED_PROJ
	

	2011370
	ADJ Sponsored NIHcap2
	SPONSORED_PROJ (Note: not used in Phase 1)
	

	2011371
	ADJ Recruitment
	RECRUIT_FAC_STARTUP
	For users of Faculty Portfolio, these projects are used primarily to supplement project-specific planning that is done in FP.  For units that do not use FP, these projects provide an ability to plan sponsored activity and other faculty/PI projects at an aggregated level.   

	2011372
	ADJ Retention
	RETENTION
	

	2011373
	ADJ Other Faculty/PI*
	FAC_PI_OWNER_ACTV
	

	2011374
	ADJ General
	GENERAL
	Adjustment projects used to plan additional activity not covered by an existing project.  May also be used to avoid planning at the project level. 

	2011375
	ADJ Affiliations
	AFF_AGREE_CON
	

	2011376
	ADJ Pgm Investments
	PROG_INVESTMT
	

	2011378
	ADJ MC Activities
	MED_CTR_ACTV
	

	6000468
	ADJ Loan
	LOAN_STU_FAC_STAFF
	

	8001131
	ADJ Recharges
	RECHARGE
	

	8500020
	ADJ Recharges External
	RECHARGE_EXT
	

	8800131
	ADJ Costed Central
	COSTED_CEN_ACTV
	


*This project refers to Other Faculty/PI Owner Activity.  The description is abbreviated in UPlan. 
[bookmark: _Toc439936477]Projects Planned in Faculty Portfolio
Not all projects can be planned at the project level in UPlan.  Sponsored Projects and Recruitment, Retention and Other Faculty/PI projects can be planned at the project level in Faculty Portfolio (FP), but not in UPlan.  A data feed from FP will provide aggregated expense plan about these projects to UPlan.  On the Revenue & Expense form, planners will be able to select and view the total expense plan for each of these Project Uses at an aggregated level.  In other words, on this form, planners will not be able to see detail by project, but rather the total for sponsored projects, the total for recruitment projects, etc.  Note that only the current year and future Plan Year 1 data will feed from Faculty Portfolio.  Plan Year 2 plans for sponsored activity, recruitment, retention and other faculty/PI projects will be based on global assumptions.
Once in UPlan, data from Faculty Portfolio will be read-only and found in one of the UPlan-Only “FP” projects listed below. 

Note that users can plan revenue/transfers to Recruitment, Retention and Other Faculty/PI projects at the project level using the Commitment Tracking tool. 
	Project_ID
	Project Description
	Project Use
	Purpose

	2011364
	FP Sponsored NoNIHcap
	SPONSORED_PROJ
	Aggregated projects, read-only FP data in General Planning and Employee Planning.  Revenue is calculated as equal to expenses. 

	2011365
	FP Sponsored NIHcap1
	SPONSORED_PROJ
	

	2011366
	FP Sponsored NIHcap2
	SPONSORED_PROJ
	

	2011367
	FP Recruitment
	RECRUIT_FAC_STARTUP
	Aggregated projects, read-only FP data in General Planning and Employee Planning. Available in Commitment Tracking for planning transfers  

	2011379
	FP Retention
	RETENTION
	

	2011377
	FP Other Faculty/PI
	FAC_PI_OWNER_ACTV
	


Users should use UPlan-only adjustment projects to alter their departmental plan for sponsored activity, recruitment, retention and other faculty/PI projects.  So, for example, if you need to make an adjustment to data related to an FP Recruitment project, you would use the corresponding ADJ Recruitment project ID and enter expense information.  For more information, refer to the Job Aid covering sponsored and faculty/PI projects.
The table below shows the read-only FP Project IDs and the corresponding ADJ Project IDs.
	FP Project_ID
	FP Project Description
	ADJ Project_ID
	ADJ Project Description

	2011364
	FP Sponsored NoNIHcap
	2011368
	ADJ Sponsored NoNIHcap

	2011365
	FP Sponsored NIHcap1
	2011369
	ADJ Sponsored NIHcap1

	2011366
	FP Sponsored NIHcap2
	2011370
	ADJ Sponsored NIHcap2

	2011367
	FP Recruitment
	2011371
	ADJ Recruitment

	2011379
	FP Retention
	2011372
	ADJ Retention

	2011377
	FP Other Faculty/PI
	2011373
	ADJ Other Faculty/PI


For more information about UPlan and Faculty Portfolio planning, see the UPlan Planning by Project manual.
[bookmark: _Toc439936478]Capital Projects
Total allocations for capital projects will be planned in the Commitment Tracking module.  Detailed expense budgets will not be planned in the General Planning module.  For this reason, capital projects will be shown on the Revenue & Expense form only in aggregated UPlan-only projects (Project ID 9002614 AGG Capital and Project ID 9002613 ADJ Capital).  On the Revenue & Expense form, the AGG project will show the total amount allocated for existing capital projects, while the ADJ project will show the total amount planned for additional projects that do not yet exist.  For both the AGG Capital and ADJ Capital projects, expense accounts 5300C and 5315E will be auto-populated with the planned total transfer amount.
[bookmark: _Toc383598712][bookmark: _Toc439936479]Columns in the Revenue & Expense Form
In the Revenue & Expense form, columns show these dimensions:
· Year: 2014-15, 2015-16, 2016-17, etc.
· Scenario: Actual, Forecast, Plan
· Version: Final, Working
· Period: YearTotal (expandable to months)
Here is an overview of what the columns will look like initially, if current year is 2014-152015-16:
[image: C:\Users\dbeaman\Desktop\2016-01-06_16-11-08.jpg]Seeded data
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Each column is expandable to show months.  The data in some columns are gray, indicating they are read-only.  Gray columns show financial actuals, which are fed from the PeopleSoft General Ledger, and plans that have been finalized (Final version).
Let’s take a closer look at the different columns.
[bookmark: _Toc439936480]Column 1: Prior Year – Actual Final 
The first column will contain final Actuals data from the prior fiscal year.  This data is used for variance comparison purposes only.
[bookmark: _Toc439936481]Column 2: Current Year – Actual Final
The second column will contain Actuals data for the current year for closed months.
[bookmark: _Toc439936482]Column 3: Current Year – Plan Final
The third column will contain Plan data for the current year, developed by planners during the spring planning cycle.
[bookmark: _Toc439936483]Column 4: Current Year –Forecast Working 
Column 4 contains the latest forecast data for the current year.  The Forecast column displays Actuals for months that are closed.  For open months, the Forecast will initially contain data from the Plan developed during the spring cycle, but may be updated by planners over the course of the year.  
[bookmark: _Toc439936484]Column 5: Next Fiscal Year (Year 1) – Plan Working
Column 4 will hold the working version of the Year 1 Plan.  Initially, this will contain the Year 2 Plan developed during the prior spring planning cycle.  Planners may choose to reseed the Year 1 plan using the current Forecast or simply make modifications to the previously developed plan.   See section 4.0 more information about seeding.
[bookmark: _Toc439936485]Column 6: Subsequent Fiscal Year (Year 2) – Plan Working
Column 6 will hold the Working version of Year 2 Plan.  Once planners have updated their Year 1 Plans and Level 1 and Level 2 Coordinators have adjusted global assumptions for Year 2, planners may seed Year 2 on their own.  This activity will be discussed in section 4.0. 
[bookmark: _Toc383598713][bookmark: _Toc439936486]Rows: Accounts on the Revenue & Expense Form
Rows in this form are Accounts.  Accounts are grouped and ordered on the form similar to an income statement: Revenue, Expenses, and Other Changes. 
Most planners will use the form with Account Level C.  FAS planners will use a version of the form with Account Level E.  In addition to the Level C and Level E accounts, UPlan includes a number of UPlan-only accounts to assist with planning.  These will be described below. 
A feature called “row suppression” formats the Revenue & Expense form.  When a form is initially loaded, only the rows with non-zero data will appear.  Since UPlan is prepopulated with General Ledger actuals, permanent budget plan data and FP data, most of the accounts you use for a particular DFP combination will display initially.  As a result, sometimes, you will not see revenue or expense accounts for which you want to enter data.  In this case, you may need to use the right-click menu Add Account and Remove Account features. 
[bookmark: _Toc439936487]Revenue Accounts
Revenue accounts relate to where you anticipate receiving funds.  In most cases, you will only have data for one or two revenue accounts for a given DFP combination. 
Typically, when you open the Revenue & Expense form and select your DFP settings, you will see one revenue account with data in Actual and Forecast columns.  You may possibly see data in the current year Plan.  You can update data for this account in Forecast or Plan.  If you need to add another revenue account, use the right click menu and select Add account.
One revenue account is always read-only on the Revenue & Expense form:
· Student tuition and fees (account 4300C) will be calculated and fed based on data entered on the Tuition & Fee Revenue Calculator Form.  Use the Tuition & Fee Revenue Calculator Form to enter this data.  See section 3.0 for more information about this form.  
[image: C:\Users\dbeaman\Desktop\2016-01-06_16-14-05.jpg]
[bookmark: _Toc439936488]Expense Accounts
Expense account rows show your expenditures of funds.  For a given DFP combination, you will see rows for expenses previously recorded in Actual Final, Plan Final, and Forecast Working.  If you need to plan additional expenses, you can right click and add accounts to find them.
Several expense accounts are always read-only on the Revenue & Expense form.  These are the salary and benefit accounts that are fed from the Employee Planning module.  As mentioned below, there are several UPlan-only salary and benefit accounts that can be used to make adjustments on the Revenue & Expense form.
[image: C:\Users\dbeaman\Desktop\2016-01-06_16-15-29.jpg]
[bookmark: _Toc439936489]Other Changes Accounts
The Other Changes section captures account activity that is considered “non-operating”.  Included here are capital equipment expenditures for non-sponsored activity, and a range of transfers, including dean and vice chancellor support transfers, transfers to plant and transfers to FFEs.  All of the Other Changes rows are writable for the forecast and plan scenarios.
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[bookmark: _Toc439936490]Calculated Rows in the Revenue & Expense Form
There are a number of calculated rows on the Revenue & Expense form.  These will update when you save data.  Here is a summary of how each one is calculated.
	Calculated Row
	
	Calculation

	Total Revenues  
	=
	All Revenue Accounts  + Operating Transfer Accounts 

	Total Expenses  
	=
	Expenses + Tfr Assessment Expense 

	Income / (Loss) from Operations 
	=
	Total Revenues  – Total Expenses  

	Other Changes 
	=
	Non-operating transfers  accounts + Other Changes accounts

	Change in Net Position
	=
	Total Revenues  – Total Expenses  +  Other Changes 

	Total Net Position–End of Period 
	=
	Total Net Position– Beginning of Period + Change in Net Position


[bookmark: _Toc439936491]Net Position
In the COA, Net Position as a concept replaces the concept of the unexpended balance.  Your net position represents your positive or negative balance.  There are three rows related to Net Position. 
In UPlan, Change in Net Position represents the change in your planned DFP balance over a period of time.  For example, the Change in Net Position for August equals your Total Revenues for August minus your Total Expenses for August, plus your Total Other Changes for August.  Change in Net Position can be similarly calculated for a quarter or year. 
Net Position – Beginning of Period represents your net position at the start of a particularly period.  So each month will have a Net Position ––Beginning of Period.  The Net Position – Beginning of Period for a fiscal year is equal to the Net Position – Beginning of Period for July. 
Net Position – End of Period represents your net position at the end of a particular period.   It is calculated as the sum of the Net Position – Beginning of Period plus the Change in Net Position.  Similar to Net Position – Beginning of Period, each month has a Net Position – End of Period, and the Net Position – End of Period for the fiscal year is the same as the Net Position – End of Period for June. 
Note also that the Net Position – Beginning of Period for a particular month is equal to the Net Position – End of Period for the prior month.  Thus, as you build your plans or forecasts, the Net Position – End of Period amount is calculated for each month and carried forward as the Net Position – Beginning of Period amount for each subsequent month. 
A special case is the Net Position – Beginning of Period for July.  While you are building the Plan for the next fiscal year (Year 1), the Net Position – Beginning of Period value equals the Net Position –End of Period for June of the current year (Year 0) forecast.  Once the new fiscal year starts, the Actual Net Position – End of Period value for June of the prior year becomes the Net Position – Beginning of Period value for the Forecast.
[bookmark: _Toc439936492]UPlan-only Accounts
There are two sets of UPlan-only accounts on the Revenue & Expense form.
Salary and Benefit Adjustment Accounts
The first is a set of seven salary and benefit adjustment accounts.  These can be identified on the Revenue & Expense form in the Expense account section:  unlike the salary and benefit accounts fed from the Employee Planning module, they are writable for the working forecast and plan scenarios and they are not numbered.  These accounts are available to help planners make adjustments to their salary and benefit expense plans at a DFP level, rather than at an employee level.  This is particularly useful for the Year 2 plan, since the Employee Planning module does not support employee-level planning for Year 2.  No actuals will appear in these account rows and when final forecasts and plans are sent to the data warehouse and MyReports, the values in these adjustment accounts are added to the corresponding numbered Level C or Level E accounts.  
[image: C:\Users\dbeaman\Desktop\2016-01-06_16-19-07.jpg]
[bookmark: _Toc353540115][bookmark: _Toc367774023]One special Expense account to mention is a UPlan-only account called Tfr Assessment Expense, which captures the expense side of an assessment transfer planned in the Commitment Tracking module. 
Transfer (Tfr) Accounts
The second set of UPlan-only accounts captures transfers planned in the Commitment Tracking module. These accounts appear in all three sections of the Revenue & Expense form (Revenues, Expenses, and Other Changes) and begin with “Tfr” instead of a number.  These accounts are read-only on this form.
Transfers of funds from within the campus should be planned in the Commitment Tracking module.  For example, State funding allocations from the Chancellor will be planned using the Commitment Tracking module.  Transfers planned in that module that have an approval date will be fed to General Planning.  The transfer will appear on the Revenue & Expense form as a transfer out (negative amount) for the Source DeptID and as a transfer in (positive amount) for the Target DeptID.  For both the Source and Target, the transfer will appear on the Revenue & Expense form on a Tfr account.  Other transfers similarly planned in the Commitment Tracking module will also appear on Tfr account rows.
When you are expecting a transfer, remember to communicate with the other department and decide who is going to enter it.  If the Source DeptID is going to enter this as a commitment to your DeptID in CommtPln, then it will flow to the appropriate Tfr account.  In this case, you would not enter it as part of your revenue forecast or plan so as to prevent double-counting.  If the Source DeptID chooses not to enter a “Commitment,” then simply plan for the estimated revenue in the appropriate revenue account in the Plan.  One of the advantages of having separate numbered and Tfr accounts on the form is that you can plan your direct revenue, expenses or other changes on the numbered account rows while also sending or receiving transfers via the Commitment Tracking module on the Tfr account rows.
Planned commitment transfers will appear on the rows in the Revenues, Expenses, or Other Changes section depending on the Transfer Type of the commitment and, in some cases, the Fund being transferred.  The mapping of Transfer Type and Fund to the Tfr account rows is covered in Commitment Tracking Manual but generally the Tfr accounts are used as follows:
· Revenue Tfr Accounts capture transfers of funds where the transfer is akin to the normal revenue a unit might “earn” for its operations.  Revenue transfers are transfers you would consider to be “earned” as part of your operations.  For example, recurring State funds allocations may be considered earned, since the State is paying the unit to operate an instructional program.  For example, recurring allocations of State funds will appear in the revenue section, since that support is provided in recognition for the mission of the unit. 
[image: ]
· Only one Expense Tfr Account is used.  It captures the expense side of a planned assessment transfer. 
[image: ]
· Other Changes Tfr Accounts capture planned non-operating transfers.  In some cases, these transfers are akin to subsidies.  They might come from the dean or the vice chancellor for non-operating activities.  Other examples are transfers for debt service, plant, or transfers to or from a fund functioning as an endowment (FFE).  These non-operating transfers appear “below the line,” meaning below the Total Income/ (Loss) from Operations line.  They roll up to account 5700C or 5700E.  Other Changes will be included in your Change in Net Position calculation.  (See the Calculated Rows section for more information.)
[image: ]

No actuals will appear in these rows.  When actual financial transfer transactions occur in the PeopleSoft General Ledger, the posting level (Level F) accounts used for the transfers will roll up into regular numbered Level C and Level E accounts and those actuals will appear in the corresponding numbered rows of the Revenue & Expense form. 
[bookmark: _Toc439936493][bookmark: _Toc367774009]Completion Tracking Account
In the first row, titled “Completion Tracking” you can enter a percent value.  This indicates your estimated percentage complete for the specific column.  Planners should only enter completion tracking data for a Scenario-Year combination in the YearTotal, not the month.  If it is entered in the month, it will overinflate the total percentage at the DFP combination (percentages over 100 are not helpful), and no percentage will appear in the completion tracking report.
The Completion Tracking row is colored pink for differentiation.  Information entered here will appear in the Completion Tracking report to help you or others in your department or control point understand how much planning activity is completed.  For each forecast or plan year, enter 100% for fully-completed planning for each particularly DeptID/Fund/Project combination.  Planners may use lower percentages to indicate partially completed work.
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To enter completion tracking information for a DFP combination:
Go to the Completion Tracking row and type the percent completed in the YearTotal cell.  Make sure to type a number followed by a percent sign or a decimal representing that percentage. Note: You can use whatever percentage you would like. 
If you are complete with all planning (or forecasting) for this DFP combination, you can type 100% or 1.0. 
If you are partially complete with your planning or forecasting for this DFP combination, type a percentage or decimal value representing your estimated percent complete  (such as 50% or .50 for half complete.)
Note: If you enter the percentage in the YearTotal for Completion Tracking, the same percentage will be pushed into all open periods.  (That is, it will not be spread.)
[bookmark: _Toc439936494][bookmark: _Toc378070075][bookmark: _Toc383598717][bookmark: _Toc384304040][bookmark: _Toc406504657]Tuition and Fee Revenue Calculator
The tuition and fee revenue calculator is a data entry form available to calculate tuition revenue based on enrolment levels and tuition levels.  This form should only be used by units that are the direct recipients or generators of tuition and fee revenue.  A special job aid is provided for this form on the UPlan website at brm.ucsf.edu.
[bookmark: _Toc439936495]Global Assumptions and Seeding
This section discusses how global assumptions are used in the planning process, how UPlan data is seeded, and the connection between these two concepts.  By the end of this lesson, you should be able to:
Understand what seeding and global assumptions are and how they work together
Leverage global assumptions to plan efficiently
Distinguish how global assumptions apply in different UPlan modules
Review global assumptions
Seed your revenue and non-salary expenses with or without global assumptions
Override global assumptions for individual employees
[bookmark: _Toc384304041][bookmark: _Toc406504658][bookmark: _Toc439936496]What are Global Assumptions and Seeding?
Global assumptions and seeding plans are interrelated concepts.
· In UPlan, the term seeding is used to describe how data is moved into a scenario to kick-start the working version of that scenario.
· Global assumptions are percentages that each Control Point can set to increase or decrease plans from one year to the next.
Seeding occurs in different ways and at different times, depending on the scenario to be seeded.  For 2016-17 plans and beyond, planners will decide when their plans are seeded.  Global assumptions are updated by coordinators and applied (in most cases) to Year 1 and Year 2 Plans through the seeding process.  In the case of General Planning, planners can choose to seed with or without the global assumptions.  Following seeding, planners decide whether or not to make further adjustments to their plans.  (Check with your Control Point to see if this is appropriate.)
[image: ]

[bookmark: _Toc378070078][bookmark: _Toc383598719][bookmark: _Toc384304042][bookmark: _Toc406504659][bookmark: _Toc439936497]What is Seeding?
As mentioned above, seeding describes how data is moved into a scenario to kick-start the working version of that scenario.
1. The data from external systems (PeopleSoft GL, Payroll/Personnel System, and Faculty Portfolio) into Actual and Forecast scenarios are automatic and periodic seedings. 
2. Planners will use Business Rules to seed Year 1 from their Current Year Forecast Working or their Current Year Plan Final.
3. Finally, after adjusting their Year 1 plans, planners will seed their Year 2 plans.
When users perform the task of seeding, they are using something called a Business Rule.  Many business rules run behind the scenes in UPlan, but seeding is a task you will launch when appropriate.
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[bookmark: _Toc378070079][bookmark: _Toc383598720][bookmark: _Toc384304043][bookmark: _Toc406504660][bookmark: _Toc439936498]What are Global Assumptions?
Global assumptions are percentages that each Control Point can set to increase or decrease plans from one year to the next.  Level 1 and Level 2 Coordinators can input percentage increases or decreases for specific categories of Funds and Project Uses for General Planning and for Title Unit Codes for Employee Planning.
Global assumptions will not apply in certain cases, so the global assumption in those cases is zero.  In these cases, when seeding Year 1, the Forecast value is carried forward to the Year 1 Plan and the Year 1 Plan value is carried forward to Year 2 Plan.
To reduce your planning workload, you can maximize the use of global assumptions and focus only on critical adjustments at the employee or DFP level.  How much fine-tuning you do for your planning is up to you and your Control Point.
There are some differences in how global assumptions work in the different UPlan modules.  We will go over these differences in the next section.
[bookmark: _Toc378070080][bookmark: _Toc383598721][bookmark: _Toc384304044][bookmark: _Toc406504661][bookmark: _Toc439936499]Global Assumptions and Seeding in Different Modules
In General Planning, Level 1 Coordinators can set global assumptions by Fund and Project Use for their control point.  Level 2 Coordinators can adjust these for their departments.  Coordinators enter a negative or positive percentage that maps to a group of funds and project uses.
Global assumptions are applied only when a Plan is seeded.  If you choose to use global assumptions, during seeding, global assumptions will be applied to the working version at the time of seeding, by Fund/Project Use and Year.  After seeding, planners may manually override specific dollar amounts on the General Planning Revenue & Expense form.  See UPlan Job Aid 209 for the specific funds and project uses affected by global assumptions.
In Employee Planning, Level 1 and 2 Coordinators can set global assumptions by Title Unit Code for their control points and departments.  In Year 1, the percentages apply to base salary only.  Seeding is automatic, and these percent increases or decreases will be part of the Working version of the Plan.  The Override Global % field on the Adjust Salary Data Entry Forms gives planners a mechanism to supersede the global assumptions. When you enter a value in Override Global % for an existing employee, it will apply this new increase or decrease to the original base salary even after it was seeded and global assumptions were applied to it.
For Year 2, global assumptions are available for all salary components (base salary, negotiated salary, Faculty Bonuses/Incentives and Additional/Other Salary).  Planners cannot adjust Year 2 plan data at an individual employee level.  Beyond global assumptions, planners may use salary and benefit adjustment accounts in General Planning to make changes for these expense categories for Year 2.
In Commitment Tracking, there are no global assumptions. Seeding is performed by the UPlan Administrator.
[bookmark: _Toc378070081][bookmark: _Toc383598722][bookmark: _Toc384304045][bookmark: _Toc406504662][bookmark: _Toc439936500]General Planning Seeding & Global Assumptions
Coordinators and planners have different responsibilities with respect to global assumptions and seeding activity in General Planning:
	Role
	Actions

	Level 1 Coordinator: 
	· Set global assumptions on Global Assumptions form.  Data is not impacted until plan is seeded.

	Level 2 Coordinator: 
	· Set or adjust global assumptions on Global Assumptions form.  Data is not impacted until plan is seeded.

	Planner  
	· Manually adjust plans for individual DeptID/Fund/Project combinations at the Account level, thereby overriding global assumptions for Year 1
· Seed Future Year 2 with or without global assumptions by running the seeding business rule
· Manually adjust plans for individual DeptID/Fund/Project combinations at the Account level, thereby overriding global assumptions for Year 2 


Generally, planners will review global assumptions for revenue and non-salary expenses and decide when and how to seed plans.
[bookmark: _Toc378070082][bookmark: _Toc383598723][bookmark: _Toc384304046][bookmark: _Toc406504663][bookmark: _Toc439936501]
Revenue and Non-salary Expenses Global Assumptions Form
Coordinators use the Revenue and Non-Salary Expenses Global Assumptions form to enter percentages for their Control Point or Department by Fund/Project Use.  They can enter values for Year 1 and Year 2.
Following is a screenshot of the General Planning Global Assumptions data entry form:
[image: C:\Users\dbeaman\Desktop\2016-01-07_9-06-58.jpg]
Global assumptions will not apply to certain categories, as indicated by the blacked out cells.  Thus, the form supports you in entering data only into the appropriate intersections.  For example, you cannot enter an assumption percentage for ICR Appropriations Revenue (because these transfers are planned in the Commitment Tracking module), but you can enter an assumption for ICR Appropriations Expense.
In most cases, the global assumption applies to all projects within a Fund.  For example, the global assumption for Private Gift funds would apply to all projects funded from this source.  For Sales and Service funds, the global assumptions are split for different project uses: Recharges, Costed Central Activities, and all other projects.
Global assumptions will apply only to certain revenue and expense accounts.  Certain accounts were excluded from the application of global assumptions because plans for these revenue and expense categories are more volatile, such as capital equipment expenses, and global assumptions are inappropriate.  For these revenue and expense accounts, planners will need to make manual adjustments.  UPlan 209 Job Aid for General Planning Global Assumptions provides a table showing the application of global assumptions by revenue and expense account.
Note: The black cells in the Revenue & Non Salary expense should not be used.  These intersections do not need global assumptions applied, as they are handled via the Commitment Tracking module, another data entry form or Faculty Portfolio.
To review global assumptions for General Planning:
1. From UPlan application, go to My Task List.
Expand General Planning > Seeding and Global Assumptions > Global Assumptions.
Check the DeptID in the Page Filter.
To change the DeptID, click the drop down box in the Page Filter and type the id or number for your DeptID; then click the Go icon.  [image: ]
Review the percentages entered by your coordinator(s).
[bookmark: _Toc378070083][bookmark: _Toc383598724][bookmark: _Toc384304047][bookmark: _Toc406504664][bookmark: _Toc439936502]Seeding in General Planning
Within General Planning, you have the ability to seed each year with or without using global assumptions.  Following are the seeding choices in the General Planner Task List.
 [image: C:\Users\dbeaman\Desktop\2016-01-07_9-13-07.jpg]
From this Task List, you can see that a planner can decide whether or not to use the global assumptions input by Coordinators.  Before making this decision, you can view the Global Assumptions Form to see what was entered.
After having reviewed global assumptions, you can choose to seed without global assumptions (e.g., Seed without Global Assumptions > Seed Year 1), or seed with assumptions (e.g., Seed with Global Assumptions > Seed Year 1).
To seed in General Planning:
1. From the UPlan application, open My Task List > General Planning > Seeding and Global Assumptions.
Select the appropriate business rule option for the method and timing of seeding that meets your needs:
	To…
	Select…

	Seed without assumptions in Year 1 Plan
	Seed without Global Assumptions > Seed Year 1

	Seed without assumptions in Year 2 Plan 
	Seed without Global Assumptions > Seed Year 2

	Seed with assumptions in Year 1 Plan
	Seed with Global Assumptions > Seed Year 1

	Seed with assumptions in Year 2 Plan 
	Seed with Global Assumptions > Seed Year 2


The Business Rule for your selection appears in the Content Pane.
[image: C:\Users\dbeaman\Desktop\2016-01-07_8-54-19.jpg]
In the Content Pane for this business rule, click Launch.
The Prompt for this Business Rule appears.
[image: C:\Users\dbeaman\Desktop\2016-01-07_9-15-22.jpg]
Fill in the DeptID field in the Prompt by typing or using the Member Selection if needed.  You may select a parent DeptID if you want to seed all DeptIDs under that parent.
If you chose seeding for Year 1, you will also need to fill in the prompt Select a Scenario from which to seed.  (This will be important in future years when you can select either the current year Plan or the latest Forecast.)
[bookmark: rules_21]Click Launch.
A message appears, indicating that the rule calculated successfully.
Click OK. 
To check the results, you can go to the Revenue & Expense Form and evaluate the data for the appropriate Plan year.
[bookmark: _Toc384304048][bookmark: _Toc406504665][bookmark: _Toc439936503]Seeding for Multiple DeptIDs
You can seed your planning DeptIDs individually, or you can seed for a group of Planning DeptIDs by selecting a parent DeptID in the Member selection prompt.  You cannot simultaneously seed two DeptIDs that do not share a common parent DeptID.
[bookmark: _Toc406504678][bookmark: _Toc439936504]General Planning Reports
General Planning makes use of both types of reporting: Form Reports and Hyperion FR Reports.  There are several reports related to the General Reporting module.
[bookmark: _Toc439936505]Form Reports
· Completion Tracking
· Plan Net Position
· Tuition Revenue by Selected DFP
· Tuition Revenue by Selected Year and Scenario
· Net Position – Actual and Forecast by DeptID and Fund
· Net Position – Actual and Forecast by DFP
· Net Position – Actual and Forecast by Fund
[bookmark: _Toc378070102][bookmark: _Toc406504679][bookmark: _Toc439936506]Completion Tracking 
We’ve already discussed the Completion Tracking Form Report in relation to the Account on page 21.  To recap, this is useful for seeing the status of your forecasting or planning by DFP combination.  It can also show which DFP combinations currently have data and thus help you determine where you want to forecast and plan.
This report is important for two reasons: first, it gives you and others within your control point an idea of how far along you are with your forecasting and planning process.  Second, it helps you find many of the DFP combinations you will need to address.
This report includes a right-click option to go to the Revenue and Expense form for the specific DFP combination you click on.  Simply right-click on the Project value for the DFP you want to review, and select the “Go to RevExp”.
Because of the way this report is designed, you will need to set the MyOrg preference before running this report the first time.  Once this is set, you can open the form report.
Note that if you export the Completion Tracking Report to Excel, additional hidden columns will appear.  These columns are used to determine whether a DFP combination is relevant to you.
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[bookmark: _Toc439936507][bookmark: _Toc378070103][bookmark: _Toc406504680]Plan Net Position 
The Plan Net Position Form Report identifies subtotals and net position amounts for each DFP combination for a scenario, version and year combination selected by the user.  It enables users to quickly see which DFP combinations have planned negative ending balances or negative Change in Net Position.  The report looks at DeptIDs under the designated MyOrg. Page Filters allow you to change the Year, Scenario, and Version you are viewing.  Columns include these UPlan calculated accounts:
· Total Revenue
· Total Expenses
· Income (Loss) from Operations
· Other Changes
· Change in Net Position
· Total Net Position – Beginning of Period
· Total Net Position – End of Period
This report includes a right-click option to go to the Revenue and Expense form for a specific DFP combination.  Right-click on the Project value for the DFP you want to review, and select the “Go to RevExp”.
Similar to the Completion Tracking report, you will need to set the MyOrg preference before running this report the first time.
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[bookmark: _Toc439936508][bookmark: _Toc383518172][bookmark: _Toc406504681]Additional Net Position Form Reports
Several additional form reports are designed to help planners identify DeptIDs, funds, and projects that are or will be in deficit during the current year.  These reports all display net position information for both actuals and forecast for the current year, at different levels of DFP detail.  
· Net Position –Actual and Forecast by DFP
· Net Position –Actual and Forecast by DeptID and Fund
· Net Position –Actual and Forecast by Fund
When they are initially run, the reports show the Change in Net Position, Net Position-Beginning of Period and Net Position-End of Period values for each row for both current year Actuals and current year Forecast.  The Change in Net Position column is expandable to show Total Revenues, Total Expense, and Total Other Changes.
[bookmark: _Toc439936509]
Hyperion Financial Reports (FR) 
· Current Year Forecast v Future Plan
· Current Year Plan v Forecast
· Scenario by DeptID
· Scenario by Month
· Scenario by Posting-level Fund
· Scenario by Project Use
· Scenario by Summary-level Fund
General Planning includes variance reports to compare your working Forecast with your Plans.  These reports are all Hyperion Reports, and you will find them in the Explore reporting repository in the General Reports-Tfr Accounts Separated folder.
[bookmark: _Toc439936510]Current Year Forecast v Future Plan
This report compares the Year 0 Forecast with the Year 1 and Year 2 Plan in $ and %.
[bookmark: _Toc439936511]Current Year Plan v Forecast
This report compares Year 0 Plan Final with Year 0 Forecast Working in $ and %.
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Following is an example of the Forecast Working versus Plan report:
[image: C:\Users\dbeaman\Desktop\2016-01-07_12-59-00.jpg]
[bookmark: _Toc439936512]Adjustment Accounts added
Values for the UPlan-only non-numbered salary and benefit adjustment accounts that appear on the Revenue & Expense form in General Planning are added to the regular numbered salary and benefit accounts in the General Planning Variance Reports.  Thus you will not see the non-numbered adjustment accounts as rows in the reports.
[bookmark: _Toc439936513]Scenario Reports
General Planning includes scenario reports that provide more detail for a specific scenario.  Instead of showing multiple scenarios in the columns, these reports include months, funds, projects, or DeptIDs as columns.   These reports are all Hyperion FR Reports, and you will find them in the Explore reporting repository in the General Reports-Tfr Accounts Separated folder.  These reports all display accounts at Level C.  
· Scenario by Month – Level C 
· Scenario by Posting-level Fund –Level C 
· Scenario by Summary-level Fund – Level C
· Scenario by Project Use – Level C
· Scenario by DeptID – Level C
Selecting DeptIDs on the Scenario by DeptID Report
After you select the Year, Scenario, Version, Fund, and Project values in the Point of View interface, a second prompt will appear, labeled “Respond to Prompts”.  This is where you will select the DeptID(s) you want for your report.
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To begin, click on the small search icon.
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Then, use the Search box or drill down to identify the DeptIDs you want.  
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Once you have selected a DeptID, click on the right arrow icon indicating “Add to selected.”
You can repeat this step for additional DeptIDs.
If you change your mind, you can remove a DeptID by clicking on the left arrow icon to “Remove from selected.”
The selection populates inside the Selection box.
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Once you are finished, click OK to run your report.
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In the Scenario by DeptID report for example, you can click on the DeptID arrow in blue to expand the report to children DeptIDs.[image: C:\Users\dbeaman\Desktop\2016-01-07_13-09-27.jpg]
In this example, if you wish to change the DeptID entirely, navigate to View > Click “Respond to Prompts”.
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The prompt menu comes up again.
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“The fallowing prompt has been defined i the report. You may use the default values shown, o selectcther members. a
prompt Selection Source
SELECT DeptiD: Report: Scenario by DeptiD - Level C
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‘The following prompt has been defined in the report. You may use the default values shown, or select other members. a
Prompt Selecton Type Source
SELECT Deptd: | 315000: N_Schoolof Report Report: Scenario by DeptlD - Level C
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‘The following prompt has been defined in the report. You may use the default values shown, or select other members. a
prompt Selection Type Source
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